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ЛАБОРАТОРНА РОБОТА №1 Тема: Початок роботи з растровими зображеннями в програмі ERDAS IMAGINE. Види і навігація. Мета: Ознайомитися з інтерфейсом ERDAS IMAGINE. Навчитися завантажувати зображення в ERDAS IMAGINE і керувати їх переглядом. Вивчити основні панелі інструментів. Вихідні дані: 1. Космічний знімок Lanier.img 2. Тематичний ґрунтовий шар Lnsoils.img 3. Тематичний гідрологічний шар Lnhydro.img 4. WV-2 космічний знімок seattle_wv-2.img 5. Landsat TM космічний знімок tm_00.img 6. Дані з AVHRR (Advanced Very High Resolution Radiometer) usa_avhrr_class.img Порядок виконання: Ознайомлення з інтерфейсом ERDAS IMAGINE 1. Запускаємо програму ERDAS IMAGINE. Завантажиться програма і у відкритому вікні можна побачити меню ERDAS IMAGINE і Вид # 1 (2D View # 1). 

 Рис. 1.1. меню ERDAS IMAGINE і Вид 
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Основна термінологія: 1) Вид - вікно, в яке виконується завантаження зображень. 2) Стрічковий інтерфейс - дозволяє виконувати загальні завдання. 

 Рис.1.2. Стрічковий інтерфейс 3) Ретривер (пошуковик) - Легкий і простий спосіб швидко отримати доступ до файлів. 

 Рис.1.3. Панель "Ретривер" 
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3) Діалогові вікна 

 Рис. 1.4. Діалогові вікна  

 Рис. 1.5. Вибір файлів 
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2. Додамо у Вид # 1 космічний знімок Lanier.img. Для цього виконаємо операцію File > Open > Raster Layer 

 Рис.1.6. Відкриття зображень у видах 3. Виберемо об'єкт для відображення в діалозі. 

 Рис. 1.7. Елементи вікна вибору файлів 
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1) Look in - вибір диска або каталогу. 2) File Selection - поле вибору окремих файлів в поточній директорії. 3) Recent - список файлів, що найчастіше використовуються. 4) Goto - список недавно відвіданих каталогів. 5) Files of type - тип файлу, який буде відкритий. 6) Preview - попередній перегляд вибраного файлу, якщо є.  4. Виберемо файл і перейдемо в закладку Raster Options. Вивчіть параметри відображення і переконайтеся, що відображення (Display as :) встановлено на True Color. Якщо потрібний параметр не відображено, натисніть на стрілку списку відображень і виберіть потрібний. 

 Рис.1.8. Закладка "Raster Options" Можливі варіанти: True Color - натуральні кольори. Pseudo Color - псевдо кольори. Grayscale - відтінки сірого. Relief - рельєф. 
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True Color - одночасно відображає неперервні шари (канали). Кожен шар пов'язаний з червоним, зеленим, синім кольором монітора. Інтенсивність кожного кольору залежить від значень пікселів у кожному шарі. Pseudo Color - відображає тематичні зображення, пов'язуючи кожне значення класу з кольором; одиночний шар. Grayscale - відображає один шар (канал). Значення групи пов'язані з відтінками сірого. Низькі значення - темні, високі значення - яскраві. Relief - використовується для відображення висотних даних.  5. Встановіть прапорець біля поля Fit to Frame (зображення впишеться у вікно Виду). 6. Перейдіть у закладку Multiple files, щоб розглянути варіанти для відображення декількох файлів в єдиному Виді. Залиште все за замовчуванням. Multiple Independent Files (Кілька незалежних файлів) - завантажує файли, індивідуально, як окремі шари, які можуть бути розташовані або видалені окремо від інших файлів у вікні перегляду. Multiple Images in Virtual Mosaic (Кілька зображень у віртуальній мозаїці) - окремі файли розглядаються як єдиний логічний файл (або шар) в одному вікні перегляду. Варіанти контрастності відносяться до всіх зображень у вікні перегляду. Multiple Images in Virtual Stack (Кілька зображень у віртуальний стек) - Дозволяє привести окремі файли (канали) мультиспектрального зображення в одне. 7. Натисніть кнопку OK, і у Виді # 1 з’явиться растровий шар. 8. Перейдіть на закладку Home блок Extent. У цьому блоці зібрані інструменти для навігації і масштабування просторових даних. 9. Виберіть інструмент Pan (Перемістити) і пересуньте зображення в довільному напрямку. 10. Коліщатком миші змініть масштаб зображення. Не змінюючи інструменту Pan, вільною рукою затисніть клавішу Ctrl і поверніть 
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зображення. Цей прийом використовується для вивчення області дослідження з різних точок огляду. 
 Рис. 1.9. Панель інструментів блоку Extent 11. Натисніть кнопку Fit То Frame , зображення буде масштабовано до розмірів екрана з тим самим кутом повороту, на якому ви зупинили обертання. 12. Щоб скинути всі зміни, пов'язані з навігацією, а також, щоб побачити зображення в його вихідному розрізненні натисніть кнопку Reset. 13. Додайте два тематичних шари. Для цього відкрийте нові Види. Перейдіть в меню File> New> 2D View. У новий другий Вид додайте Lnsoils.img, в третій - lnhydro.img. 14. Тепер спробуємо зв'язати всі три Види. Активуйте один з видів - для цього клацніть на його назві у області Contents або безпосередньо на Виді. Цей Вид тепер буде базовим. 15. Перейдіть на закладку Home основного меню програми, і 

натисніть Link Views.  у блоці Window. Усі три Види зв'яжуться.  Кнопки Link/Unlink, Sync/Unsync , котрі знаходяться в правому верхньому кутку кожного з видів дозволяють пов'язувати і синхронізувати Види незалежно один від одного.  16. Збільшіть за допомогою лупи, зображення у вікні Виду # 2. У вікнах інших видів з'являться контури масштабованої ділянки. Відключіть зв'язок між Видами.  
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 Рис. 1.10. Опрацювання зображень у зв'язаних видах Для зручності доступу до деяких інструментів можна скористатися можливістю ERDAS Imagine - Quick Access Toolbar (рис. 1.11). Ця панель призначена для організації швидкого доступу до найбільш часто вживаних інструментів. 
 Рис. 1.11. Панель Quick Access Toolbar 17. Клацніть правою кнопкою миші на інструменті Pan панелі Extent і натисніть Add to Quick Access Toolbar. Таким чином на панель швидкого доступу можна додати будь-який інструмент.   Порівняння даних з різним просторовим розрізненням 18. З папки Unit 1 відкриваємо зображення із супутника Landsat TM - tm_00.img. Зображення Landsat Thematic Mapper (TM) містить 7 мультиспектральних каналів з розрізненням 28,5 метра. (Зображення з супутника Landsat ресемпльовані (стиснуті) до 30 м, не залежно від кута відхилення від надира). Дані, представлені в цьому завданні, мають 6 каналів, відсутній тепловий. Діапазон каналів зображення від видимого 
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до короткохвильового ІЧ. Також дані з Landsat 7 містять 15-метровий панхроматичний канал. 19. Вивчіть територію, використовуючи панель навігації. 20. Відкрийте Вид # 2 і завантажте в нього інше зображення - usa_avhrr_class.img. В закладці Raster options виберіть тип відображення - Pseudo Color.  Advanced Very High Resolution Radiometer (AVHRR) - знімки містять 4-6 каналів з розрізненням 1.1 кілометра. Діапазон каналів від видимого до теплового ІЧ. AVHRR зображення використовуються для вимірювання температури поверхні (моря, землі і хмар), виявлення хмар, снігового / льодового покриву, моніторингу рослинності і т.д. В даному випадку дані представлені в якості тематичного зображення рослинного покриву, створеного на основі даних AVHRR. AVHRR дані особливо актуальні для вивчення змін клімату та деградації навколишнього середовища через наявність архівних даних за тривалий період (понад 20 років). 21. Просторово зв'яжіть ці види. Подивіться на відмінності просторового розрізнення. 

 Рис. 1.12. Зображення з різним просторовим розрізненням 22. Зробіть активним Вид із зображенням AVHRR. Перейдіть в закладку Table в активному блоці Raster. Натисніть на інструмент - Show Attributes . 
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23. З'явиться таблиця атрибутів для цього тематичного зображення. Тут можна побачити назви класів і відповідні їм кольори, які ви можете змінити на ваш розсуд. 

 Рис. 1.13. Таблиця атрибутів тематичного зображення Для кращого розпізнавання цього знімка, накладемо карту Сполучених Штатів. 24. Натисніть на іконку Open Layer в меню Швидкого Доступу. 25. У діалоговому вікні Select Layer to Add, розкрийте список опції Files of Туре і виберіть Arc Coverage. Arc Coverage - цифровий векторний формат, який містить інформацію про атрибути в каталозі «info» та інформацію про координати в каталозі шару. Arc Coverage може містити точки, дуги, полігони, точки підписів, посилання, екстент карти та інструкції. Крім того, він може зберігати інформацію про проекції. 26. Перейдіть на C: \ Program Files \ Intergraph \ ERDAS IMAGINE 2014 \ etc \ backdrops і зі списку виберіть usa. Натисніть ОК. 27. З векторною інформацією, вибраною в Table of Contents, перейдіть на вкладку Style. 28. Натисніть Viewing Properties в групі View. 29. У діалоговому вікні властивостей обраного векторного шару зніміть прапорець біля опцій Points і Polygon. Натисніть Apply, потім Close. 30. Перейдіть до таблиці атрибутів, щоб подивитися інформацію про ваш векторний файл. 
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31. Закрийте 2D Вид # 2. У вас повинен залишитись лише tm00.img в 2D Виді. 32. Перейдіть з закладку Multispectral, щоб відобразити функції для конкретного типу даних, які виділені у вікні Contents. 33. У блоці Bands ви можете змінити комбінацію каналів зображення. Якщо можливо, програма сама визначить тип сенсора. Переконайтеся, що це Landsat 4 ТМ - 6 Bands. 34. У наступному рядку Common Band Combinations виберіть ТМ True Color. Дослідіть територію, використовуючи різні комбінації каналів. 35. У 2D Виді # 1 відкрийте зображення seattle_wv-2.img. 36. На вкладці Multispectral у блоці Bands виберіть в якості Червоного кольору Канал_8. Подивіться як змінилася рослинність. 37. На вкладці Home в блоці View виберіть інструмент Swipe. Порівняйте зображення з сенсорів ТМ і WV-2. Swipe має свою власну таблицю, де ви можете знайти 4 колонки для управління даними: Locked - вибране зображення заблоковане. Під час зміни зображення залишається незмінним. Invisible - вибране зображення завжди невидиме. Working - вибране зображення видиме і є можливість застосування інструменту Swipe. Необхідно, щоб хоча б 1 шар був робочим. Останній шар в списку не може бути робочим, так як не існує шару під ним. Static - вибране зображення видиме, але залишається статичним і не змінюється від пересування інструменту Swipe.  ЛАБОРАТОРНА РОБОТА №2 Тема: Основні способи покращення відображення знімків. Мета: навчитися оптимізувати зображення для різних завдань (друку, візуального аналізу, детального перегляду, і т.д.). Освоїти маніпуляції з каналами, регулювання контрасту та яскравості. Вихідні дані: 1. geoeye.img - GeoEye - 1,50см супутниковий знімок міста Обухів. 2. Набір супутникових знімків Landsat (7 файлів) території Каїра (Єгипет). 3. Дані з супутника WorldView-2.   
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Порядок виконання Робота з одноканальними панхроматичними зображеннями та об'єднання їх у єдине мультиспектральне растрове зображення. 1. Завантажте всі зображення Landsat.TIF з робочого каталогу в порожній Вид. Матеріали: Landsat ТМ 5, розрізнення 28,5 м, місто Каїр, дата: 2003/09/25. 2. Дослідіть кожне зображення візуально та проаналізуйте основні характеристики зображень за допомогою операції Home > Metadata. Діалогове вікно Image Metadata містить дані про такі важливі характеристики зображень як тип та розмір файла, кількість шарів (каналів), вид проекції, роздільна здатність та ін.  

 Рис. 2.1. Метадані зображення Це одноканальні панхроматичні зображення. Кожне з цих чорно-білих зображень несе інформацію, отриману в певній області спектра. 3. Об'єднаємо всі канали в єдине растрове зображення. Для цього треба виконати команду Raster > Spectral > Layer Stack. 
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 Рис. 2.2. Формування стеку 4. У діалоговому вікні натисніть кнопку  поруч із випадаючим списком поля Input File. Перейдіть у робочий каталог і виберіть всі 7 зображень Landsat. Натисніть ОК. Всі файли будуть згруповані в *.vsk файл, який буде відображатися в полі Input File. 5. У полі Layer: виберіть All та натисніть кнопку Add. В списку відобразиться файл з розширенням *.vsk. 6. У полі Output File введіть назву результуюючого (об'єднаного зображення) Cairo.img. 7. Залиште інші опції за замовчуванням і натисніть кнопку ОК. Завантажиться вікно списку процесів. 

 Рис.2.3. Вікно списку процесів 8. Після закінчення процесу закрийте список процесів і завантажте Cairo.img в новий Вид. 9. Перейдіть на вкладку Multispеctral і, в блоці Bands, встановіть відповідність каналів для діапазону RGB - Layer 3, Layer 2 і Layer 1. 
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10. Активуйте інструмент Discrete DRA. Дослідіть зображення. Опція Discrete DRA дозволяє автоматично виставляти найкращі для дешифрування значення контрасту та яскравості для даного конкретного екстенту. ІІ. Комбінації каналів Будемо використовувати спектральні відбивні характеристики відомих об'єктів і каналів супутника Landsat ТМ, щоб легше ідентифікувати об'єкти на знімку. 1. У Виді відкриємо зображення Cairo.img. 2. Відкрийте вкладку Multispectral. Переконайтеся, що у блоці Bands, випадаючий список Sensor Types відображає 5 опцій: • Landsat 4 ТМ; • Landsat 7 MS; • Landsat 5 ТМ; • MODIS Reflective-7; • Custom; 3. З першого випадаючого списку виберіть Landsat 5 ТМ. 4. З другого випадаючого списку комбінацій каналів виберіть ТМ False Color IR. Перевірте відповідність каналів для видимого діапазону RGB: Layer_4, Layer_3, і Layer_2. Ця комбінація називається - "Близький інфрачервоний колір" і є однією з найбільш часто вживаних.  
 В даному випадку об'єкти будуть відображені наступними кольорами (таблиця 2.1): Таблиця 2.1 Відображення угідь на знімках Landsat 5 ТМ в комбінації каналів "Близький інфрачервоний колір" Тип угіддя Колір Рослинність  Червоний Сільськогосподарські культури Від рожевого до червоного Водно-болотні угіддя Темно-червоний Вода Відтінки синього або чорного кольору Забудова Від блакитного до світло-зеленого Відкрий грунт Від блакитного до світло-зеленого 
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5. У блоці Bands вкладки Multispectral змініть комбінацію каналів на Red:5, Green:4. Blue:3. Це "Короткохвильовий інфрачервоний колір", де об'єкти відображаються наступним чином (таблиця 2.2): Таблиця 2.2 Відображення угідь на знімках Landsat 5 ТМ в комбінації каналів "Короткохвильовий інфрачервоний колір" Тип угіддя Колір Рослинність  Відтінки зеленого Сільськогосподарські культури Відтінки зеленого Водно-болотні угіддя Відтінки зеленого Вода Від темно-синього до чорного  Забудова Фіолетовий Відкрий грунт Пурпурний або блідо-рожевий  6. Тепер змініть комбінацію каналів на Red: 3, Green: 2, Blue: 1. Цей спосіб відображення називається Натуральний колір, так як ми присвоїли червоний колір для червоного каналу, зелений колір для зеленого і синій колір для синього каналу. Об'єкти повинні відобразитися в такий спосіб (таблиця 2.3): Таблиця 2.3 Відображення угідь на знімках Landsat 5 ТМ в комбінації каналів "Натуральний колір" Тип угіддя Колір Рослинність  Оливково-Зелений Сільськогосподарські культури Середньо і світло-зелений Водно-болотні угіддя Темно-зелений або чорний Вода Відтінки синього і зеленого Забудова Від білого до світло-сірого Відкритий грунт Від рожевого до світло-коричневого  7. Поекспериментуйте з різними комбінаціями каналів. 8. Кожен канал окремо так само може бути інформативним. Відкрийте другий Вид, зробіть його активним та завантажте в нього цей же растр, тільки попередньо зайдіть на вкладку Raster Options і змініть Display As на Gray Scale і канал для відображення Display Layer виберіть 1. Натисніть ОК. 
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9. В результаті відобразиться тільки Канал 1 в градаціях сірого. Зв'яжіть два види, за допомогою інструменту Link Views на вкладці Home та дослідіть обидва зображення. 10. На вкладці Panchromatic змініть відображення каналу Show Layer на інші. Розгляньте кожен канал окремо і дослідіть, які об'єкти краще відображаються в тому чи іншому каналі. 11. Після цього, очистіть обидва Види, натиснувши Clear View.  Дослідження комбінацій каналів VorldView-2. 12. З робочої папки відкрийте у Виді зображення wv2_8band.img. Це дані з супутника VorldView-2. Знімки з VorldView-2 містять 8 каналів мультиспектрального зображення з роздільною здатністю 1.66 метра. Так само є панхроматичний канал з роздільною здатністю 50 см. Таблиця 2.4 Опис області застосування для кожного каналу, WorldView-2 Канал Назва Довжина хвилі (нм) Застосування 
1 Фіолетовий / прибережний (Coastal Blue) 400-450 

Використання оптимальне при глибоководних дослідженнях і обчисленні деяких вегетативних індексів. Випромінювання в даному діапазоні поглинається хлорофілом в здорових рослинах, що сприяє проведенню вегетаційного аналізу. Вивчення атмосферного розсіювання. 
2 Cиній 450-510 Також проникає крізь спокійну водну поверхню, але не так глибоко, як і канал 1. Поглинається хлорофілом, але менш піддається розсіюванню і поглинанню в атмосфері. 
3 Зелений 510-580 Найточніше фокусується на максимумі відбитої енергії здорової рослинності, оцінює її життєздатність; використання цього каналу спільно з даними зйомки в жовтому діапазоні ефективне для розпізнавання типів рослинності. 
4 Жовтий 585-625 Дуже важливий при класифікації об'єктів. За даними зйомки в цьому каналі виявляється жовтизна (зниження вмісту хлорофілу) конкретних рослин на землі і в воді. 
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продовження таблиці 2.4 
5 Червоний 630-690 Один з найважливіших каналів зйомки для виділення рослин і оцінки їх стану. Використання даних цього каналу ефективне для класифікації грунтів без рослинності, доріг, геологічних об'єктів. 
6 Крайній червоний 705-745 

Дуже важливий і унікальний канал, так як знаходиться на самому початку високих значень відбиття енергії від здорової рослинності. Використання даних зйомки у цьому каналі ефективне для виділення і класифікації рослинності та оцінки її стану. 7 Близький інфра-червоний-1 770-895 Дуже ефективний для оцінки вмісту вологи і біомаси. Використання даних зйомки в цьому каналі ефективне для відділення водойм від рослинності і забезпечує поділ видів рослин та ґрунтів. 8 Близький інфра-червоний-2 860-1040 
Частково накладається на БІЧ-1, але менше піддасться впливу атмосфери. Використання даних зйомки в цьому каналі забезпечує проведення більш глибокого аналізу рослинності і дослідження біомаси. Піддається впливу водяної пари.  13. Використовуючи наступні комбінації каналів, вивчіть територію.  5,3,2 (Червоний, Зелений, Синій) Комбінація каналів "природнього кольору". Оскільки в цій комбінації використовуються видимі канали, наземні характеристики проявляються в кольорах подібних зоровій системі людини: здорова рослинність зелена, недавно зібрані поля дуже світлі, нездорова рослинність коричнева і жовта, дороги сірі, берегові лінії білі.  7,5,3 (Близький ІЧ, Червоний, Зелений) Стандартна композиція, "неприродні кольори". Рослинність проявляється у відтінках червоного, міські райони блакитно-сині і ґрунти варіюються від темно- до світло-коричневого. Лід, сніг та хмари білі або світло-блакитні. Хвойні дерева проявляються червоними, але темнішими, ніж листяні. Це дуже популярна комбінація каналів і корисна для 
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досліджень рослинності, моніторингу посушливих територій і стадій росту сільськогосподарських культур. Густонаселені міські райони відображаються в світло-блакитному відтінку.  7,3,2 (Близький ІЧ, Зелений, Синій) Модифікована композиція "неприродні кольори". Як правило, ця комбінація каналів розрізняє хвойну, листяну і трав'янисту рослинність з більш широкою зміною відтінку, ніж стандартна комбінація неприродних кольорів. Хвойні проявляються темно-червоним кольором, листяні, як правило, повинні бути представлені в яскраво-червоними, а трав'янисті області оранжево-червоними відтінками.  7,6,5 (Близький ІЧ1, Крайній червоний, Червоний) Комбінація каналів "рослинність". Ця комбінація охоплює ділянку спектра, де хлорофіл переходить від поглинання до відбивання і ілюструє деякі з характеристик, представлених в індексах рослинності. Хвоя проявляється в коричнево-зелених відтінках, в той час як трава і посіви, проявляються в жовтих і оранжевих відтінках. Добре помітні невеликі зміни в рослинному покриві. Відкритий ґрунт і гірські породи виявляються в сіруватих відтінках.  8,4,1 (БІЧ 2, Жовтий, Прибережний) Ця комбінація забезпечує широкомасштабне представлення різних типів рослинного покриву у різних кольорах. Рослинність проявляється червоною, забудова синьою із сильною градацією, що відображає зміни цих об'єктів.  8,7,6 (БІЧ 2, БІЧ 1, Крайній червоний) Ця комбінація каналів фокусується на ближньому ІЧ спектрі, зображуючи і підкреслюючи рослинність в жовтому кольорі. Допомагає проілюструвати рослинність, воду і забудову з більш високим ступенем контрастності.  3,2,1 (Зелений, Синій, Прибережний) Ця комбінація каналів забезпечує найбільше проникнення в товщу води і багату батиметричну інформацію. Зелена рослинність проявляється у відтінках червоного. Глибина води змінюється від сірого, до зеленого і синього. 
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ІІІ. Зміна яскравості і контрасту зображення 1. У Вид # 1 завантажте растровий файл geoeve.img. Це фрагмент знімка міста Обухів Київської області, з супутника GеoEyе-1 за березень 2010 року. 2. Подивимося інформацію про це зображення, використовуючи інструмент Home > Metadata. Зверніть увагу, що зображення має 16-бітну глибину кольору.  3. За допомогою кнопки Fit to Frame впишіть зображення у вікно перегляду.  4. Перейдіть на вкладку Multispectral. Змініть налаштування яскравості і контрасту, використовуючи повзунки блоку Brightness Contrast. Візуально оцініть зміни. 5. У Вид # 1 довантажте растровий файл geoeyе.img, попередньо відзначивши на вкладці Raster Options No Stretch (без розтяжки) і виставивши канали Red: 3, Green: 2, Blue: 1. Натисніть OK. Завантажене зображення буде виглядати темним та мало контрастним. За замовчуванням, ERDAS IMAGINE відображає зображення, використовуючи розтяжку Вирізання у відсотках - Percent Clip (Percentage LUT); так зображення відкривається без застосування цієї розтяжки. Дуже часто діапазон значень даних растрового зображення не збігається з діапазоном значень яскравості дисплея. Таким чином, розтягування контрастності зазвичай розширює діапазон значень, щоб відповідати діапазону дисплея. Наприклад, на рисунку нижче показаний шар, який має значення файлу даних від 30 до 40. Коли ці значення використовуються в якості значення яскравості, контраст зображення, що відображається буде дуже низьким. Розтяжка контрастності просто розтягує діапазон між нижніми і високими значеннями даних, в результаті чого контраст зображення стає вищим. Тобто низькі значення даних відображаються з найнижчими значеннями яскравості, а більш високі значення даних відображаються з найвищими значеннями яскравості. Палітра розтягує діапазон колірних значень від 30 до 40, в діапазон від 0 до 255. Оскільки вихідні значення збільшуються через регулярні інтервали, ця розтяжка є лінійною. (Цифри на рисунку приблизні і не показують точного лінійного співвідношення). 
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 Рис. 2.4. Розтягування контрастності 6. На вкладці Multispectral виберіть Adjust Radiometry  З випадаючого списку виберіть Standard Deviation Stretch (блок Standard Stretches). 7. Скасуйте останню дію за допомогою інструменту Undo  на панелі швидкого доступу, щоб повернутися до вихідного зображення. 8. Щоб подивитися, як змінюються значення яскравості, виберіть Adjust Radiometry> Breakpoints. 9. З випадаючого списку Adjust Radiometry знову виберіть Standard Deviation Stretch. Подивіться як змінилася гістограма. 

 Рис. 2.5. Гістограма зображення без розтяжки та з розтяжкою методом стандартних відхилень 
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10. У вікні Breakpoint Editor натисніть Apply Аll. Розтяжка буде застосована до зображення. 11. Закрийте Breakpoint Editor. 12. На вкладці Multispectral виберіть Adjust Radiometry > General Contrast. 13. Змініть Method на Histogram Equalization, змініть джерело для розрахунку гістограм Histogram Source на все зображення - Whole Image. Натисніть Apply. 14. Змініть розтяжку на Percentage LUT. 

 Рис. 2.6. Вікно налаштування параметрів розтягнення контрасту 15. Поексперементуйте з різними типами розтяжок. 16. Збільшіть зображення кар'єру в північно-східній частині знімка. 17. Натисніть Adjust Radiometry > General Contrast, і у вікні Contrast Adjust Ви можете застосовувати спеціальні алгоритми для зміни яскравості / контрастності. 18. У полі Method встановіть Standard Deviation і кількість стандартних відхилень встановіть 8.0, натисніть Apply і Close. Таким чином, ми застосували метод стандартних відхилень для яскравості / контрасту всього зображення. Зверніть увагу, що раніше невидимі деталі, такі як пісок тепер видно набагато краще. 19. Активуйте опцію Discrete DRA. Вона дозволяє автоматично виставляти найкращі для дешифрування параметри яскравості і контрасту для даного конкретного екстента. 20. Перейдіть на вкладку Ноme і введіть значення 1: 2000 в поле Extent. Ми встановили масштаб перегляду знімка 1: 2000 (в 1 см 20 метрів). Тепер встановіть масштаб перегляду 1: 500. 
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21. Поверніться на вкладку Multispеctral і в блоці View встановіть Resampling Method (Метод Ресемплінгу) на Bilinear Interpolation (Білінійна інтерполяція), зверніть увагу, як змінилося зображення. Методи Ресемплінгу: Найближчий сусід: • Заміняє значення DN на значення найбільш близького пікселя. Передає вихідні значення яскравості пікселів без їх усереднення. Зберігає крайні значення. • Підходить, для використання перед класифікацією. • Найшвидший спосіб обчислення. • Результат має ступінчастий перехід по діагоналі. Білінійна інтерполяція: • Вибирає середнє зважене значення із чотирьох найближчих пікселів. • Просторово більш точний, ніж найближчий сусід; більш згладжений, менш ступінчастий. • Все ще швидко обчислюється. • Значення пікселів усереднюються, згладжені краї об'єктів і екстремальних значень. Кубічна згортка: • Оцінює блок з 16 найближчих пікселів, не строго лінійна інтерполяція. • Середнє значення і дисперсія вхідного файлу і результуючого збігаються, проте інші значення даних можуть бути змінені. • Може одночасно зробити зображення різкішим і згладити шум. • Розрахунок складніший, тому займає більше часу. Бікубічний сплайн: Поверхня, отримана в результаті бікубічної інтерполяції, є більш згладженою, на відміну від поверхонь, отриманих в результаті білінійної інтерполяції або інтерполяції методом найближчого сусіда. Цей метод інтерполяції є найкращим, але потребує серйозних обчислювальних ресурсів.  IV. Зміна бітності зображення 1. Очистіть Вид # 1 за допомогою інструменту Home > Clear View без збереження зміни контрасту, і додайте знову зображення geoeye.img. 
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2. Перейдіть на вкладку Raster основної панелі інструментів і запустіть інструмент Radiometric > Rescale. 3. У вікні зміни глибини (бітності) кольору, в блоці Data Туре, встановіть Output > Unsigned 8 bit. 4. Введіть ім'я і тип результуючого файлу rescale_8bit.img. Натисніть ОК. 5. Після завершення перетворення, закрийте вікно Process List, і довантажте rescale_8bit.img в поточний Вид. 6. Увімкніть Discrete DRA. 7. У блоці View встановіть Resampling Method на Bilinear Interpolation. 8. За допомогою інструменту Swipe, оцініть візуальну різницю між 8 і 16-бітовим зображеннями. 9. У провіднику відкрийте вашу робочу директорію, порівняйте розміри вихідного 16-бітного файлу і створеного 8-бітного. Можна зробити висновок, що для друку і перегляду зручніше використовувати 8-бітове зображення. 16-бітові, маючи велику глибину кольору, в основному, використовуються для виявлення об'єктів в тінях, засвічених територіях, а також для професійного спектрального аналізу. 10. Очистіть Вид.  V. Просторове покращення. Convolution filtering (Фільтр згортання) - процес об'єднання невеликих наборів пікселів по всьому зображенню. Матриця з певними значеннями проходить по всьому зображенню і застосовує усереднене зважування до конкретних пікселів. Цей процес може бути корисний у виявленні певних особливостей, наприклад, контурів об'єкта. 1. У Виді знову відкрийте зображення geoeye.img. 2. Встановіть масштаб відображення - 1: 800. 3. Перейдіть на вкладку Multispectral. 4. У блоці Sharpness (Різкість), натисніть на інструмент Filtering (Фільтр). Виберіть Convolution Filtering. Інструмент Convolution Filtering дозволяє фільтрувати зображення, що відображається у вікні перегляду. Він дозволяє виконувати такі операції, як усереднену, високочастотну або низькочастотну фільтрації. 

       

      



27  

5. У блоці Kernel цього інструменту виберіть 7x7 Edge Enhance. Переконайтеся, що в полі Apply to (Застосувати до) виставлено On-Demand (За запитом). Ця дія виконає поліпшення зображення, а саме додасть різкості межам об'єктів. 6. Натисніть Apply і ОК на повідомлення, яке з'явилося: Фільтр, застосований за запитом, не буде збережений. Якщо ви хочете зберегти зміни, то вам потрібно виставити в полі Apply to (Застосувати до) - Whole Image (Все зображення). 7. У вікні інструменту Convolution Filtering, натисніть на Edit ..., Це матриця, яка буде проходити по всьому зображенні. Натисніть File -> Close. 8. Скасуйте попередню дію - Undo Previous Raster Edit. 

 Рис 2.6. Вікно інструменту фільтрації зображень 8. Використовуючи цей же інструмент, спробуйте інші способи поліпшення зображення: • 3x3 High Pass • 7X7 Low Pass • 5x5 Haze Reduction 9. Очистіть Вид.
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 ЛАБОРАТОРНА РОБОТА №3 Тема: Використання профільних інструментів для топографічного аналізу.  Мета: Навчитись будувати просторові профілі за заданим напрямком та профілі поверхонь використовуючи цифрову модель рельєфу. Вихідні дані • dem_99.img - ЦМР. • hydro_00.shp - векторний шар річок. • clearcut.aoi - векторний шар зони вирубки. • river.dat - файл у форматі ASCII з координатами річки. • tm_00.img - зображення із супутника Landsat ТМ.  Порядок виконання Використання векторного шару для вивчення топографії. Ми досліджуємо топографію навколишньої місцевості, щоб зрозуміти подальший вплив на потік води. 1. У 2D Виді, відкрийте dem_99.img у якості моделі рельєфу і векторний шар hydro00.shp. 2. Правою клавішею миші натисніть на векторному шарі і з контекстного меню виберіть Fit Layer to Window. 3. Натисніть на відрізок річки на сході, щоб виділити його. 4. Виділіть dem_99.img на панелі даних. Далі перейдіть на вкладку Panchromatic. 5. Виберіть Просторовий фільтр (Spatial Profile) із випадаючого списку.  

 Рис.3.1. Набір профільних інструментів Спектральний Профіль (Spectral Profile) дозволяє візуалізувати спектр відображення кожного пікселя по всіх каналах. Цей метод 
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особливо корисний для гіперспектральних даних, які можуть мати сотні шарів. Цей метод дозволяє оцінити хімічний склад матеріалу в пікселі. Можна порівняти згенеровані профілі, з профілями лабораторних (або польових) спектрофотометрів. Просторовий Профіль (Spatial Profile) дозволяє візуалізувати спектр відображення полілінії значень файлу даних в одному каналі (одновимірний режим) або в декількох каналах (перспективний тривимірний режим). Найбільш поширеним прикладом одноканального профілю є той випадок, коли цифрова модель рельєфу (ЦМР) використовуються для створення профілю уздовж заданого маршруту.  Профіль Поверхні (Surface Profile) дозволяє візуалізувати цифрову модель поверхні в межах обраної прямокутної області. 6. У вікні Просторового профілю виберіть інструмент Показати профіль для обраних векторів (Show Profile for selected vectors). Перегляньте профіль. 

 Рис.3.2. Вікно просторового профілю 7. У вікні просторового профілю, вибравши в закладці Edit пункт Chart Options можна змінити параметри візуалізації профілю. У полі (Plot Background) можна змінити колір фону, а в полі (Solid Color) - колір заливки профілю. 8. На вкладці Y-Axis, можна змінити максимальне значення (Мах), для детальнішої візуалізації профілю (наприклад, встановити значення 500). Після вибору усіх параметрів натискаємо Apply і Close. 
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9. За допомогою команди Реверсування напрямку лінії (Reverse the direction of the line) можна змінити напрям лінії профілю. 10. Закрийте вікно профільного інструменту. Потім натисніть File - Close - Close Top Layer, так щоб у Виді залишилася тільки ЦММ. Якщо програма попросить зберегти символіку, натисніть No. 11. У Виді, який містить файл dem_99.img, натисніть File - Open - AOl Layer і додайте clearcut.aoi - векторний шар зони вирубки. 12. Наблизьтеся до зони інтересу (натисніть на ній правою клавішею і в контекстному меню виберіть Fit Layer to Window). 13. Виберіть ЦМР на панелі даних і перейдіть на вкладку Relief (або вкладку Panchromatic, якщо зображення відображено в відтінках сірого - Grayscale). 14. Виберіть інструмент Просторовий фільтр (Spatial Profile).  15. У повідомленні, що з'явилося натисніть ОК. 16. У вікні Просторового фільтра (Spatial Profile) натисніть на інструмент Створити нову лінію профілю (Create New Profile Line) . 17. У Виді, оцифруйте лінію через площу зони інтересу. Подвійний клік, щоб закінчити оцифровку. Профіль з'явиться у вікні Spatial Profile. 18. Лінію профілю у Виді можна змінювати, рухати вузли або переміщувати всю лінію. Відображення просторового профілю буде змінено відповідно. 19. Вивчіть зміни рельєфу в середині та навколо нашої зони інтересу у вікні просторового профілю. Щоб краще зрозуміти річкові процеси, було б корисно згенерувати профіль річки. Чим крутіший профіль, тим сильніша ерозія.  Щоб згенерувати профіль річки, ви можете оцифрувати полілінію уздовж річки або можете ввести наперед відомі координати. 20. У Виді, виберіть лінію профілю та натисніть Пробіл. Відкриється вікно редагування полілінії, де будуть вказані координати вершин. 21. За допомогою клавіші Shift виділіть колонки X і Y. натисніть правою клавішею мишки на заголовку однієї з колонок. Відкриється контекстне меню. 22. Виберіть Import і з робочої папки відкрийте файл river.dat. Ви повинні побачити координати всіх точок. 
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23. Натисніть ОК у вікні Poly Edit. Перегляньте результат у вікні просторового профілю. 24. На вкладці Home, змініть масштаб відображення на 1: 100000. Ви побачите лінію профілю у Виді. 25. У вікні Просторового Профілю перейдіть на вкладку Viewer Tic Points. 26. Відзначте Add symbols, інші параметри залиште за замовчуванням. 27. Відзначте Label text і в полі Text color виберіть жовтий колір тексту. 28. Натисніть Apply. 29. У вікні просторового фільтра виберіть File - Save Chart As. 30. Збережіть файл в робочій папці під ім'ям рrоfіІе.ovr і натисніть ОК, потім закрийте вікно просторового профілю.  31. Перейдіть на вкладку Relief (або Panchromatic) і виберіть інструмент профілю поверхні Surface Profile. 

 Рис. 3.3. Профільні інструменти 32. Натисніть на інструмент Create Box in Viewer . 

 Рис.3.4. Вікно поверхневого профілю 
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33. У Виді, намалюйте полігон поверх будь-якої території ЦМР. 

 Рис.3.5. Вибір зони для побудови профілю поверхні 34. У вікні профілю поверхні, виберіть Edit - Overlay TrueC'olor. 35. Виберіть tm_00.іmg в якості шару, який ми накладемо на поверхню і натисніть ОК. 36. У вікні профілю поверхні, виберіть Edit - Chart Options. 37. Вимкніть відображення поверхні Wire Frame. Натисніть Apply і Close. 

 Рис. 3.6. Текстурований профіль поверхні  38. У Виді змініть розмір і положення полігону профілю, щоб переглянути інші території.
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 ЛАБОРАТОРНА РОБОТА №4 Тема: Координатна прив'язка і геометричне трансформування знімків. Мета: Навчитись виконувати координатну прив'язку і геометричне трансформування знімків за опорним знімком. Вихідні дані 1. Неприв'язаний знімок Unreferenced.jpg. 2. Космічний ортотрансформований знімок Reference.tif. Порядок виконання 1. Запустіть Erdas IMAGINE. В Вид # 1 завантажте растровий шар Unreferenced.jpg - це знімок без будь-якої прив'язки, скачаний з сайту GoogleMaps. Якщо з'явиться запит на побудову пірамід, натисніть Yes.  2. На вкладці Multispectral з групи Transform & Orthocorrect виберіть пункт Control Points та запустіть його. 

 Рис. 4.1. Меню групи Transform & Orthocorrect 3. У списку моделей трансформування виберіть Polynomial (Поліноміальна трансформація) і натисніть ОК. 

 Рис.4.2. Вибір геометричної моделі трансформування 
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4. У верхній частині екрану, з'явиться панель з інструментами для геометричної трансформації (Multipoint Geometric Correction) і ви побачите діалогове вікно для вибору джерела координат (GCP Tool Reference Setup). 

 Рис. 4.3. Вибір джерела отримання координат для трансформації 5. У діалоговому вікні GSP Tool Reference Setup (рис. 4.3) необхідно вибрати джерело отримання координат. У даній лабораторній роботі виконується прив'язка знімка до опорного зображення, тому в якості джерела опорних точок виберіть Image Layer (Новий Вид) і натисніть ОК. 6. Виберіть знімок Reference.tif, як опорне зображення. Натисніть ОК. З'явиться вікно (Reference Map Information), в якому міститься інформація про систему координат опорного зображення (Reference.tif). Натисніть ОК. 

 Рис. 4.4. Інформація про систему координат опорного знімка 
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7. З'явиться вікно Polynomial Model Properties. Встановіть поліном 1-го порядку. Натисніть Close (Закрити). 

 Рис. 4.5. Вибір порядку полінома  Erdas IMAGINE відкриє на екрані Вид з опорним зображенням і додаткові Види зі збільшеними зображеннями. 

 Рис. 4.6. Редактор опорних точок Після відкриття редактора опорних точок Multipoint Geometric Correction (рис. 4.6) за замовчуванням буде активована опція Toggle Fully Automatic GCP Editing Model . Цей режим зручно використовувати для попередньої оцінки (прогнозу) розташування опорних точок і для уточнення відповідності опорних точок на вихідному (Source) і опорному (Referenced) знімку. 
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8. Перемістіть зв'язуючі рамки двох видів таким чином, щоб вони покрили один і той же розпізнаний об'єкт (наприклад, добре розпізнаний кут забору). 
 Рис. 4.7. Встановлення зв'язуючих рамок Натисніть кнопку Create GCP  (Створити опорну точку). Тепер клацанням миші розмістіть відповідні точки в обох збільшувальних вікнах Видів. 

 Рис. 4.8. Розміщення опорних точок на вихідному та опорному знімках 9. Як тільки це зроблено, можна перейти до розпізнавання наступного об'єкта на знімках. Поставте ще дві опорні точки. 10. При натиснутій кнопці  Toggle Fully Automatic GCP Editing Mode після встановлення трьох опорних точок Erdas IMAGINE при введенні опорної точки в одному вікні Виду автоматично визначить приблизне (імовірне) місце розташування цієї точки в другому Виді. 11. Для кращого відображення на знімках опорних точок, можна змінити колір маркерів опорних точок з білого на будь-який інший. Для цього клацніть на прямокутник кольору (Color) в таблиці опорних точок і виберіть новий колір для окремої опорної точки або виберіть кілька рядків (тобто точок) і встановіть колір для всіх обраних. 12. За аналогією наберіть ще 4-5 опорних точок. Намагайтеся розташувати їх рівномірно по всьому знімку. У редакторі опорних точок можливе видалення та редагування опорних точок. Для видалення точки виберіть відповідний рядок у таблиці, натисніть праву клавішу мишки і з контекстного меню виберіть Delete Selection (Видалити вибране). 
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13. На панелі інструментів геокорекції (Multipoin Geometric Correction) клацніть кнопку Display Resample Image Dialog . 14. З'явиться вікно Resample (Передискретизація) задайте ім'я вихідного файлу xrectify.img. 

 Рис. 4.9. Вікно передискретизації 15. У рядку Resample Method (Метод передискретизації) вкажіть метод білінійної інтерполяції (Bilinear Interpolation). 16. Активуйте опцію Ignore Zeros (Ігнорувати нулі при розрахунку статистики). Переконайтеся, що інформація про проекцію присутня в лівій частині діалогу. 17. Встановіть галочку навпроти Force Square Pixels on reprojection (примусово робити пікселі квадратними при передискретизації)  18. Натисніть ОК, щоб почати трансформування. 19. Коли процес буде завершений, натисніть кнопку Close (Закрити) у вікні з рядком стану процесу. 20. Закрийте вікно Multipoint Geometric Correction через File> Exit tool. Якщо ви зробили будь-які зміни в редакторі контрольних точок з моменту останнього збереження, вам буде запропоновано зберегти їх. Натисніть Yes, щоб зберегти поточну модель і назвіть її - xrectify.gms. Пізніше відображається запит щодо збереження вихідних і контрольних точок. Натисніть Yes обидва рази. 
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21. Використовуючи інструмент Clear View  на вкладці Home, щоб видалити всі шари з Виду # 1. Відкрийте оригінальний Refcrence.tif і трансформований знімок xrectify.img в Виді # 1. 22. За допомогою інструмента Swipe, оцініть результат трансформації.  

 Рис. 4.10. Оцінка результату трансформації  ЛАБОРАТОРНА РОБОТА №5 Тема: Ортотрансформування знімків. Мета: Навчитись виконувати ортотрансформування знімків з використанням опорних точок, RPC-коефіцієнтів та цифрової моделі рельєфу. Вихідні дані 1. Набір супутникових даних - папка 052233229010_01_P001_PSH (оригінальні дані від постачальника, знімок з супутника Quickbird м. Алушта від 23.04.2009, продукт PSM Ortho-Ready, тобто готовий до орторектифікації), файл самого знімка - 09APR23085146-S2AS-052233229010_01_P001 .TIF (розмір 792 Мб). 2. Дані рельєфу SRTM relief utm.img 3. Набір опорних точок, GCP from field.txt 
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4. Абриси опорних точок, abris1-4.jpg 5. Схема розташування опорних точок, abris_all.jpg  Порядок виконання Завдання 1. Ортотрансформування з опорними точками 1. Запустіть Erdas IMAGINE. 2. Завантажте з робочої папки зображення 09APR23085146-S2AS-052233229010_01_P001.TIF у Вид # 1. 3. З тематичного меню Raster> Multispectral запустіть інструмент Control Points. 

 Рис.5.1. Інструмент опорних точок З'явиться діалогове вікно, де ви повинні вибрати геометричну модель трансформації. 

 Рис. 5.2. Вибір геометричної моделі трансформації 
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4. Зі списку виберіть геометричну модель Quickbird RPC. Натисніть OK. 5. Відкриється редактор опорних точок та діалогове вікно GCP Tool Reference Setup, яке запропонує вам вибрати метод набору опорних точок. Виберіть Keyboard Only. Натисніть OK. 

 Рис. 5.3. Вибір методу набору опорних точок 6. У наступному діалоговому вікні Reference Map Information (Інформація про прив'язку) встановіть систему координат UTM WGS84 Zone 36 N в наступній послідовності: 

 Рис. 5.3. Інформація про прив'язку 
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 Рис. 5.5. Вибір системи координат 

 Рис. 5.6. Вибір зони 7. У вас на екрані має з'явитися діалогове вікно Qucikbird RPC Model Properties (властивості моделі супутника Quickbird). Переконайтеся, що файл RPC- коефіцієнтів автоматично завантажився в поле RPC file. 8. Встановіть порядок поліноміальної трансформації «1». Підключіть у якості джерела рельєфу для даної території файл relief_utm.img. 
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 Рис. 5.7. Властивості моделі супутника Quickbird 9. Переконайтеся, що в закладці Projection встановлена система координат UTM WGS84 Zone 36N.  

 Рис. 5.8. Система координат Потім натисніть Apply і Close. 10. Розгорніть вікно набору опорних точок на весь екран. 11. Використовуючи абриси опорних точок з робочої папки, а також текстовий файл GCP_from_fieId.txt, складений за матеріалами польових робіт, наберіть п'ять опорних точок. Для цього використовуйте інструмент Create GСР . Введіть планові координати (X, Y) і координату висоти (Z). 
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 Рис. 5.9. Абрис опорної точки №1 

  Рис. 5.10. Вікно набору опорних точок 
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12. За допомогою інструменту оцініть точність введених даних. Переконайтеся, що RMS Error менше, ніж 1. 13. На панелі інструментів геокорекції (Multipoint Geometric Correction) натисніть на кнопку Display Resample Image Dialog . 14. У вікні Resample (Передискретизація) задайте ім'я вихідного файлу orthofinal.img. Вкажіть метод найближчого сусіда (Nearest Neighbour) в рядку Resample Method (Метод передискретизації). 

 Рис. 5.11. Вікно передискретизації 15. Увімкніть прапорець Ignore Zeros (Ігнорувати нулі при розрахунку статистики). Переконайтеся, що інформація про проекцію є в лівій частині діалогу. 16. Поставте галочку навпроти Force Square Pixels on rеprojеction (примусово робити пікселі квадратними при передискретизації) Натисніть ОК, щоб почати ортотрансформування. 17. Після завершення процесу, натисніть Close у вікні з рядком стану процесу. Закрийте вікна інструменту геокорекціі (Multipoint Geometric Correction), виконавши операцію File> Exit. Якщо ви вносили якісь зміни в редакторі опорних точок після останнього збереження, вам буде запропоновано їх зберегти. Натисніть Yes (Так) для збереження поточної моделі і назвіть її model.gms. 
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18. Далі підуть запити на збереження вихідних і опорних точок безпосередньо в структуру файлів відповідно вихідного і опорного, обидва рази натисніть Yes. 19. За допомогою інструменту Clear View на Вкладці Home, видаліть з Виду # 1 всі зображення. 20. Завантажте у Вид # 1 вихідні дані 09APR23085146-S2AS-052233229010_01_P001.TIF і трансформований вами знімок ortho final.img. 21. Оцініть різницю і очистіть вид.  Завдання 2. Ортотрансформування без опорних точок. Цей тип орто дозволить усунути спотворення за рельєф і за місце розташування супутника. Є два варіанти, як ви можете це зробити.  Варіант 1. Використовуючи стандартні інструменти. 1. Ha вкладці Raster виберіть інструмент Geometric Calibration> Orthorectify without GCP. 

 Рис. 5.12. Орторектифікація без опорних точок 2. Відкриється вікно Geo Correction Input File. Виберіть з вашої робочої папки зображення 09.APR23085146-S2 AS-052233229010_01_P001.TIF. Натисніть ОК. 3. Виберіть зі списку геометричну модель Quickbird RPC. Натисніть ОК. 4. З'явиться діалогове вікно Qucikbird RPC Model Properties (рис. 5.7). Переконайтеся, що RPC коефіцієнти автоматично відобразилися в полі RPC File. 
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5. Додайте джерело рельєфу місцевості rеliefutm.img. 6. На вкладці Projection вкажіть систему координат UTM WGS84 Zone 36N. Після цього натисніть Apply. 7. Відкриється вікно Resample. Як ім'я для вихідного файлу введіть -orthorectify_geocor.img, вкажіть метод ресамплінгу Nearest Neighbor. Відзначте Ignore Zeros in Stats і Force Square Pixels on reprojection. Натисніть OK, щоб почати процес орторектіфікаціі.  Варіант 2. Використовуючи модуль Imagine Photogrammetry. 1. З вкладки Toolbox, виберіть інструмент Imagine Photogrammetry.  

 Рис. 5.13. інструмент Imagine Photogrammetry Відкриється вікно LPS Project Manager. 

 Рис. 5.14. Менеджер проектів LPS 
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2. Щоб створити новий проект, натисніть File > New. Задайте ім'я - Ips.blk. ОК. 3. Відкриється вікно Model Setup. У рядку Gеomеtriс Model Category виберіть Rational Functions. Виберіть геометричну модель QuickBird RPC. Натисніть ОК. 

 Рис. 5.15. Вибір геометричної моделі 4. Відкриється вікно Block Property Setup, вкажіть систему координат UTM WGS84 Zone 36N coordinate System. Натисніть ОК. 5. Клацніть правою кнопкою миші на папці Image у вікні даних зліва і виберіть Add.  

 Рис. 5.16. Завантаження знімка до проекту Знайдіть зображення - 09APR23085I46-S2AS-052233229010_0I_P001.TIF. Натисніть ОК. Цей знімок буде приєднаний до проекту. 
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6. Виберіть Edit > Frame editor. Переконайтеся в тому, що файл з RPC коефіцієнтами був автоматично завантажений в поле RPC coefficients. Натисніть ОК. 

 Рис. 5.17. Завантаження блоку в менеджер проекту 7. З меню Process виберіть інструмент Ortho Rectification> Resampling ....  

 Рис. 5.18. Вибір процесу орторектифікації Відкриється вікно Ortho Resampling. На вкладці General в рядку Output File Name задайте ім'я для вихідного файлу в робочій папці - orthorectify_lps.img. 
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8. Як джерело рельєфу (DTM Source) виберіть DEM. У рядку DEM File Name виберіть опцію Find DEM ... і знайдіть relief utm.img. 

 Рис. 5.19. Вікно передискретизації 9. На вкладці Advanced як метод ресамплінгу задайте Nearest Neighbour. OK. Процес почнеться. Після закінчення процесу натисніть Close. 10. Порівняйте отримане зображення з вихідним.  Лабораторна робота №6 Тема: Створення мозаїки зображень в ERDAS IMAGINE. Мета: Навчитись створювати мозаїки із декількох знімків та редагувати лінії зшивки зображень. Вихідні дані: • Wasia1_mss.img - знімок Landsat MSS. • Wasia2_mss.img - знімок Landsat MSS. • Wasia3_tm.img - знімок Landsat TM. • ortho1.img - південна частина ортофотоплану Києва (знімок Geoeye-1, від 31 серпня 2010 року). 
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• ortho_2.img - північна частина ортофотоплану Києва (Geoeye-1 від 9 травня 2011 року). Створення мозаїки - це процес об'єднання окремих зображень в єдине. Всі вихідні зображення повинні містити однакову кількість каналів (хоча вони не обов'язково повинні мати однакову проекцію і однаковий розмір комірки растру (cell size). Процес створення мозаїки в ERDAS IMAGINE включає наступні етапи: 1) додавання зображень в мозаїку; 2) вирівнювання їх яскравості / контрасту; 3) визначення лінії зшивання в області перекриття двох сусідніх зображень; 4) створення результуючого зображення.  Порядок виконання Додавання зображень в мозаїку. 1. Відкрийте Вид # 1 і завантажте в нього знімки Wasia1_mss.img, Wasia2_mss.img, Vasia3_tm.img. Щоб завантажити три зображення в один Вид не забудьте на вкладці Raster Options (Опції завантаження растра) деактивувати Clear Display (Очистити Вид перед завантаженням). Активуйте опцію Background Transparent (Прозорий фон). 

 Рис. 6.1. Налаштування опцій завантаження растру 
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З. цих трьох різних знімків ми і будемо створювати один файл мозаїки.  2. Відкрийте вікно створення мозаїки Mosaic Tool. Вкладка Raster > Mosaic > Mosaic Pro From 2D View. 

 Рис. 6.2. Порядок відкриття вікна створення мозаїки Відкриється вікно створення мозаїки - Mosaic Pro. 

 Рис. 6.3. Вікна створення мозаїки 
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Внизу робочого простору знаходиться таблиця, що містить список зображень, які будуть приймати участь у процесі створення мозаїки, а також їх атрибути (рис. 6.3). У цій таблиці зображення розташовані так, що перше зображення в списку буде розташоване під усіма іншими зображеннями при створенні мозаїки. Якщо ви хочете, наприклад, щоб зображення розташовувалося поверх інших, необхідно змінити його положення в списку і помістити його в кінець. Для цього у вікні створення мозаїки виділіть зображення (клацнути по ньому мишкою - воно виділиться жовтим) і, використовуючи кнопки з панелі інструментів вікна створення мозаїки, перемістити так, як це вам необхідно. 3. Розташуйте знімки у порядку wasia1, wasia2, vasia3. 4. Для того, щоб включити видимість шарів необхідно натиснути інструмент  і поставити галочки біля необхідних шарів у стовпці Vis таблиці атрибутів. Зображення, біля якого в стовпці Ref (Reference) стоїть галочка, буде головним в процесі вирівнювання гістограм. Тому необхідно визначитися з тим, яке зображення буде "визначальним" до того, як ви будете використовувати інструменти для вирівнювання гістограм. 5. Задайте визначальним знімок wasia1. Поставте галочку навпроти нього в колонці Ref. Вирівнювання гістограм зображень. 6. Натисніть на інструмент Display Color Corrections Options Dialog  на панелі інструментів вікна мозаїки (аналогом цієї операції є процедура Edit | Color Correction). Вона відкриває діалогове вікно Color Correction, в якому можна вибрати параметри вирівнювання гістограм. Color Correction - це набір інструментів для вирішення проблем з відмінностями тональностей та яскравостей зображень, з яких створюється мозаїка. Ви можете виключити аномальні області в процесі вирівнювання гістограм, використовуючи інструмент Set Exclude Areas (використовується тільки, якщо активовані наступні методи: Histogram Matching і Color Balancing).  Приклади областей, які можуть бути виключені: • Ізольовані яскраві міські райони • Сонячні відблиски 

       

      



53  

• Темні водні області • Хмари Use Illumination Equalizing - вирівнює освітлення і колір занадто темних, надто світлих і областей з колірним зсувом. В основному використовується для панхроматичних зображень. Use Image Dodging - фільтр з використанням глобальної статистики, проходить по всьому вікні і коригує світловий дисбаланс на зображенні. В основному використовується для злиття аерофотознімків. Use Color Balancing - вирівнює зміни яскравості зображень, передбачає, що варіації можуть бути змодельовані у вигляді поверхні. Use Histogram Matching - функція вирівнювання гістограм коригує гістограму кожного зображення і підганяє її таким чином, щоб зробити схожою з гістограмами інших зображень блоку. Процес вирівнювання гістограм базується на припущенні, що причиною яскравості і тональних відмінностей між зображеннями є зовнішні фактори, такі як атмосферні умови на момент зйомки і умови освітленості земної поверхні. 

 Рис. 6.4. Вибір параметрів вирівнювання гістограми У діалоговому вікні виберіть Use Histogram Matching і натисніть кнопку Set, з'явиться діалог параметрів вирівнювання гістограми.  7. Встановіть в рядку Matching Method (метод вирівнювання) - For All Images (для всіх знімків), а в рядку Histogram Туре (Тип гістограми) - Band By Band (пошарово). Натисніть OK. 
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8. На знімку Wasia1_mss.img, який є опорним при вирівнюванні гістограм, явно присутня колірна аномалія, яку слід виключити з розрахунку. У діалоговому вікні Color Correction встановіть галочку навпроти Exclude Areas, натисніть Set. 

  Рис. 6.5. Вибір параметрів для виключення колірних аномалій З'явиться робочий простір, що дозволяє виділяти і виключати аномальні території. 

 Рис. 6.6. Виділення аномальних зон на знімку 9. За допомогою інструменту Create Polygon AOl , обведіть засвічену область в південній частині знімка  Vasia1_mss.img. Натисніть Apply. Таким чином, ми вказали область, яка не братиме участі в загальному розрахунку. 10. Перегляньте інші зображення, вибираючи потрібне зі списку в лівому нижньому кутку вікна Set Exclude Areas. При необхідності в такій же спосіб виключіть занадто яскраві або занадто темні об'єкти. 
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11. Натисніть Apply Тo Аll і Close.  12. Натисніть ОК у вікні Color Correction. Натисніть кнопку  і з'явиться діалогове вікно Set Overlap Function, встановіть функцію розрахунку яскравостей пікселів в зоні перекриття - Overlay. Натисніть ОК. Є 5 функцій, які визначають величину області перекриття: 

 Рис. 6.7. Функції розрахунку яскравостей пікселів в зоні перекриття Визначення лінії стику в області перекриття 13. Натисніть на інструмент розрахунку лінії зшивки  Seamline Generation Options і встановіть Seamline Generation Method (Спосіб генерування ліній стиків) - Weighted Seamline (Зважені лінії стикування).  14. Натисніть ОК. Програма розрахує лінії стикування відповідно до заданого алгоритму.  

 Рис. 6.8. Генерування ліній зшивки зображень 
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Збереження результатів мозаїки 15. Натисніть Output Image Options , з'явиться вікно налаштувань результуючого файлу. Тут можна задати конкретну область для створення мозаїки, змінити систему координат і роздільну здатність. Залиште всі параметри без зміни. Натисніть ОК. 16. Натисніть кнопку збереження результатів на диск , у вікні введіть ім'я файлу mos1.img. Натисніть ОК. Завантажиться вікно списку процесів. 

 Рис. 6.9. Вікно списку процесів Дочекайтеся завершення процесу створення мозаїки. Натисніть Close. 

 Рис. 6.10. Зшите зображення 17. Збережемо проект мозаїки. Натисніть File > Save As в робочій області MosaicPro і збережіть проект мозаїки під ім'ям mos.mop. Краще не закривати вікно Mosaic Pro до того, як переконаєтеся, що вас влаштовує результат. 
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Редагування лінії зшивки зображень 18. Завантажте у Вид ortho_1.img і ortho_2.img, з них ми будемо зшивати єдине зображення. 19. Відкрийте вікно створення мозаїки Mosaic Tool і натисніть на інструмент  для автоматичного визначення лінії зшивки. 20. У вікні Seamline Generation Options виберіть Weighted Seamline. Натисніть Set ... і задайте довжину сегментів (Segment Length) 300 рх.  

 Рис. 6.11. Вибір параметрів лінії зшивки Натисніть кнопку ОК у всіх вікнах, які відносяться до параметрів лінії зшивки. 21. Відредагуйте лінію зшивки за допомогою інструменту Edit Polygon seams  Курсор перетвориться на хрестик.  

 Рис. 6.12. Фрагмент автоматичної лінії зшивки Першу точку слід помістити на той знімок, який ви хочете розмістити зверху. Потім оцифруйте шов таким чином, що він не перетинав будівлі чи інші чіткі однорідні контури. Намагайтеся, щоб шов 
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проходив вздовж доріг, річок або через рослинність. Цифрування треба закінчувати на тому ж знімку, на якому почали. Переконайтеся, що нова лінія зшивки перетинає стару тільки в двох місцях, як на рисунку зліва.  

 Рис.6.13. Редагування лінії зшивки зображень Після закінчення цифрування, ви відразу ж візуально побачите наскільки помітна лінія зшивання. 22. Продовжуйте цифрувати, щоб змінити лінію зшивки приблизно як на зображенні нижче (зробіть її максимально непомітною): 

 Рис. 6.14. Відредагована лінія зшивки зображень 23. Натисніть кнопку Color Correction  і активуйте тільки Use Histogram Matching. 24. Запустіть процес мозаїкування кнопкою , назвавши файл як mosaic.img.  25. Після завершення, відкрийте зшите зображення та оцініть його якість. 
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